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New Year Resolutions for the PC User 
 

1. Start recycling your old electronics.   Do you 

have old computer parts, dead electronics, 

and outdated gadgets?  It is time to clean 

house.  But we want to consider the environ-

ment and not just throw these items away.  Lo-

cally we are fortunate that we have the ability 

to easily recycle them at the Lorain County Col-

lection Center  http://tinyurl.com/4srgz5e  They 

accept all of  these kinds of items  for proper 

handling and more!  If you are not a Lorain 

County resident there is probably a similar pro-

gram in your community.   

 

2. Back up your hard drive!  If a hardware crash 

hasn’t happen to you yet – this could be the 

year!!  Get a good computer back up program 

or use the one that comes with Windows 7.  

These programs will make it easy to start a regu-

lar backup program.   External hard drives that 

can be used for back up storage have never 

been cheaper!  Or try one of the online auto-

matic backup services.  This is the year you WILL 

do a regular backup routine!! 

 

3. Digitize your old photos and slides.  Equipment 

available to do this is also cheaper and easier 

than ever to use.  Check the services available 

locally at places such as Walgreens or Costco.  

There are also online services such as http://

www.scanmyphotos.com/   Using such a ser-

vice is a lot less exapensive than you would 

think and they promise same day turn around. 

 

4. Clean up your computer so it will run better.  

This is probably something you have been in-

tending to do regularly every month as recom-

mended.  If, like most PC users, you don’t keep 

to that schedule at least do this now at the start 

of the year!  A good article on what to do to 

make this happen http://www.sync-blog.com/

sync/2010/10/7-ways-to-speed-up-a-slow-

pc.html  or look back on the PowerPoint that 

Lou Koch shared with us after his talk on this 

topic.  You will find that on the club webpage 

under http://lccug.com/nlinks.html.  After you 

do this, your computer will start quicker and run 

smoother! 

5. Learn something new!  Learn to use a new pro-

gram, master some tips and tricks in using your 

computer’s operating system.  Learn to do 

something online that you’ve never done be-

fore!  Keep in mind that there are many online 

tutorials available to help you learn just about 

anything! 

 

6. If you’re younger – make it a goal to not text or 

use social media overly much and to do more 

constructive things.  If you are older, learn how 

to use the features of your cell phone, twitter 

and facebook.  

 

7. Take the time to discover your digital camera’s 

manual modes.  Many users just set the camera 

on auto and are satisfied with the results.  But 

learn to understand the elements of exposure 

to help you take better pictures. Again there 

are MANY online tutorials to walk you through 

the steps. 

(Continued on page 8) 
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On Site or Walk In Services  

440-322-0259 
210 East Second St., Elyria 44035 

New Systems Upgrades 

Diagnostics Installations 

Virus Removal System Tune Ups 

Rebuilt Systems 

TUESDAY 

February 8, 2011 
TUESDAY 

February 22, 2011 

Learn All About 

Ebooks 

 

Presented by  
 

Sandee Ruth 

Computer Crash  

Reconstruction 

 

Presented by  
 

Henry Lipian 

Mr. Lipian owns his own Crash Reconstruction Com-

pany and is located in Amherst. 

 

He will be presenting infor-

mation on the history of this 

process, how he got into the 

business, what is it all about, 

including computer programs 

and who uses his information 

besides insurance companies, police departments, 

and hospitals. 
 

Crash Forensics provides complete motor-vehicle 

forensic crash reconstruction also documentation 

and analysis of physical roadway evidence, includ-

ing forensic mapping of vehicle damage profiles 
 

Mr. Lipian will also have a question and answer 

time for those inquiring LCCUG minds. 

What are e-books, where do you get them, what 

do you read them on, and just how cool is this 

concept?  Sandra, a retired librarian, will try to 

help us sort it all out and provide us with a wealth 

of interesting information and updates. 
 

Sandee Ruth's background is library work and 

books galore!   She also loves to be on the cutting 

edge of anything new with computers, so when 

Ebooks came out it was a match made in heaven! 
 

Sandee knows where to find all kinds of books from 

all kinds of places and what is the best and most 

up-to-date equipment to read them on.    
 

Come hear all about Ebooks and what is happen-

ing with this interesting concept along with lots of 

hints and tips. 
 

Learn about the various Ebook readers available, 

the various Ebook formats and the issues with com-

patibility. Both audio books and Ebooks will be 

touched on. 
 

The program will be followed by a question and 

answer period. 
 

Amazon is now selling more Ebooks than paper-

backs.  Find a out what it is all about! 

Genealogy Sites I have visited: 
 

http://www.gengateway.com/ 
 

Ancestor Hunt 

http://www.ancestorhunt.com/ 
 

Check out some of these sites and just maybe you’ll find 

your own long lost ancestor.  You just never know. 

http://www.dcparts.com
http://www.dcparts.com
http://www.dcparts.com
http://www.dcparts.com/
http://www.dcparts.com
http://www.dcparts.com
http://www.dcparts.com
http://www.dcparts.com
http://www.crashforensics.com/forensicmapping.cfm
http://www.gengateway.com/
http://www.ancestorhunt.com/
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Executive Board  

Meeting Minutes 

General 

Meeting Minutes 

Newsletter Editor:  Pam Rihel using Microsoft Publisher, Corel 
Paint Shop Pro X3, CreataCard 8.  

 

This Month’s contributors: Micky Knickman, Sandra Ruth, Kaye 
Coller, Pam Rihel, Carole Doerr, Don Hall, Wordtips.net, 
Exceltips.net, Smart Computing Magazine, Dick Eastman, Stephen 
Bigelow, Trevor Meers, Microsoft Office art online, PC Computer 
Magazine, www.worldstart.com, http://sangrea.net/free-cartoons/
comp_elderly-internet.jpg 
 
 

Newsletter is now 
Online 

at 
lccug.com/newsletters or lccug.com 

JANUARY 4, 2011 
 

Attending were Sandee Ruth, Carole Doerr, Don 

Hall, Micky Knickman and Dennis Smith. 
 

Carole will prepare a write-up for the newsletter 

and web page promoting our Laptop Raffle. 

Tickets will be 5 dollars each and the drawing will 

take place when 200 tickets have been sold. 
 

The Membership Raffle will start with the January 

11th meeting. Dennis will prepare the numbered 

cards for the drawing. 
 

Richard will be responsible, Micky backup, for 

getting an e-mail notice out to all members of a 

meeting cancellation due to inclement weather, 

building emergency, etc. 
 

Micky will present KeePass on the 7 PM portion of 

the January 11th meeting. 
 

Carole will have hand-outs at the January 11th 

meeting explaining the CERT program for those 

members interested in participating.  
 

The LCCUG Facebook page needs updating. Kaye 

will be responsible. 
 

Carole will work on a brochure promoting better 

meeting attendance. 
 

Micky moved, Dennis seconded the meeting be 

adjourned. 

JANUARY 11, 2011 
 

President Sandee Ruth called the meeting to order. 

A motion to accept the minutes as shown in the 

January issue of the INTERFACE was made by Ken 

Kohler, seconded by Nancy Smith. Motion Passed. 
 

Sandee then told of the club’s upcoming trip to the 

Homeland Security Office in Elyria,  the laptop 

computer the club will raffle and Pam and Jean’s 

classes this month. 
 

Mark McKinley of the National Weather service lo-

cated in the Oberlin FAA center gave an interest-

ing and informative presentation on the many or-

ganizations and facilities available across the coun-

try that follow and predict weather up to a year in 

advance. Mark’s own office has 18 computers on 

all the time, some showing reports from the other 

121 offices across the US. He told of the 80 weather 

balloons in the air at heights from 90,000 to 100,000 

feet in the air all the time. There are 150 ships and 

buoys reporting weather conditions along with 

7,000 small stations. 
 

An interesting fact about the Doppler radar was 

that it can show the conditions at 50 to 64 vertical 

layers in height. 
 

John Louzy won the money raffle and Stan 

Ketcham won the first software/hardware raffle. 

Claudia Jones name was drawn for the attend-

ance raffle however she was not present. 
 

Ray Stevens moved, Carole Doerr seconded the 

meeting be adjourned. 
Ohio Computer Repair Service 

47375 Cooper Foster Park Road 
Amherst, Ohio 44001 

(440) 984-5265 

 

The Problem: 

Computers can be very fun and frustrating at the same time. 
This may be a surprise to some, but 90% of everything that goes 
wrong with a computer is configuration related. The problem is, 

there are just too many settings to change and modify, and most 
people don't even know where these settings are.  

The Answer: 
You could read and study like I did for the last 14 years. You 

could experiment with your computers on a daily basis until you 
get it right, or search the Internet and find more sites than any 

ten people could read in a lifetime. You could accidentally break 
your computer more times than you care to remember, or you 

can call us, Ohio Computer Repair Service.  

The Result: 
A computer that runs all the time with no errors, no surprises, 

and does it faster and better than when it was brand new. 

http://www.wordtips.net
http://www.exceltips.net
http://www.worldstart.com
http://www.lccug.com/newsletters
http://www.lccug.com
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 Pam Rihel  LadyGeneo@roadrunner.com 

WHY WRITE YOUR  
STORY? 

By Pamela M. Rihel 

2011 
 

I feel that writing about your life is important for 

many reasons.  You are here and can remember 

your memories from events that took place in your 

life.  Ask yourself questions like; what is my first 

memory, what was that memory, how many other 

childhood memories can I write about?   
 

I have been writing things about my life for some 

time now and I hope to pass in on to my sons and 

grandchildren when I am gone.  This will help them 

understand what my childhood was like in the past 

years as compared to theirs now. 
 

You have to write the good with the bad memories 

and add as many photos as possible to make the 

story more interesting.  I have many black & white 

photos of my younger years and I don’t know if my 

grandchildren even realize that we didn’t have 

color photos until the early 60’s. 
 

When I got married in 1968, we couldn’t afford to 

have our wedding photos done in color, so all my 

wedding pictures are in black & white.  Now that 

would be a surprise to the children of today, don’t 

you think? 
 

I also use my tape recorder to record what I am 

thinking and doing on certain days and then I tran-

scribe them to paper.  I never erase the tape re-

cordings just in case I lose what I have written.  

Some memories come in flashes for me.  Some-

times it will be a familiar smell from my past or a lit-

tle De Ja` vu of places or even people that remind 

me of someone I may have met in my past. 
 

There are really so many ideas that you can put to 

paper and it seems the more I write the more I re-

member.  I describe the houses I have lived in and 

where they were located, what stores were around 

when I was young, what animals we owned and 

what kind of personality did they have.  You would 

be surprised at the stories you can tell that are very 

interesting and even fun to read. 
 

I like to look back and remember my family and 

friends, my school days, my marriages, etc.  I don’t 

have a really exciting life, but for me it is all I have 

and I am mostly proud of what I have done with 

my time on this earth.  Not to say I didn’t make mis-

takes along the way, but who hasn’t? 
 

I went to Germany from 1968 to 1969 and we lived 

off base for 14 months, I loved every minute of it.  I 

was also lucky enough to go to Ireland twice, once 

with my sister-in-law and her mom and sister in 2002 

and again in 2004 with three friends.  We did some 

research on the later trip, but alas I didn’t find any 

information on my ancestors.  I wrote 2 journals 

while on these two trips and I wish I would have 

thought to do the same while I was in Germany, 

but at 20 and pregnant I didn’t even give it a se-

cond thought.  I must now rely on my memories to 

write about my stay in Germany.  Even after 41 

years I can still remember my time spent there like it 

was last week.   It is fun to re-read these stories and 

remind myself just what life is all about. 
 

Later I want to start writing about my time spent 

with my own boys and now my grandchildren and 

what fun we have when they come to visit.  I am 

also very close to my nieces and nephews and so 

they will be added to my stories as well.  I really 

hope that they will enjoy the stories as much as I 

had writing them. 
 

Things you can write about: 

You childhood 

Your parents 

Your grandparents 

The homes you lived in 

The cars you owned 

The pets you had and have now 

Your children 

Your grandchildren 

Your jobs 

Places you lived other than your hometown 

Favorite foods then and now 

Friends 

Schools, colleges, trade schools 

Books you like to read 

Boyfriends or girlfriends you have had 

Marriages 

Places you have visited 
 

Now what can you think of to put into your story?  I 

bet it will be interesting not only to your family but 

to you as well.  Don’t be afraid to write about your-

self; you matter to your family and friends and to 

your descendants.  Good Luck  

mailto:LadyGeneo@roadrunner.com
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WIN A NEW LAPTOP! 
 

LCCUG Board members are excited to announce 

that our club will be sponsoring a raffle to win a 

brand new HP Laptop computer, starting in Janu-

ary.  There will be only 200 tickets sold.  
 

HP EliteBook 8440p laptop 

Core i5 2.4 GHz Dual Core Intel processor 

2 GB Ram 

250 GB Hard Drive, Sata 7200 rpm 

DVD/CD RW 

14 inch screen 

Nvidia graphics processor 512K 

2 megapixel integrated camera 

Fax/modem 

SD/Multi-card reader 

Intel Wireless Network Interface card 

Windows 7 Professional 

Includes the following software: 
 

WinZip, HP Quick Launch Button Software, HP Pro-

tectTools Security Manager, HP Client Manager 

Software (free download), HP Wireless Assistant, 

Synaptics Touchpad Driver, HP QuickLook 3, Mi-

crosoft Office Professional 2007 (60 days trial), 

McAfee Total Protection for Small Business (60 

days trial), HP Webcam Software, PDF Complete 

Special Edition, HP SoftPaq Download Manager, 

HP Recovery Manager. 
 

Please help support LCCUG by purchasing tickets.  

You could win an outstanding laptop computer 

for the mere price of a ticket.  Odds of winning 

are 1 in 200. 
 

Thank You, 

LCCUG Board 

Changing How Links 

are Activated 
 

Summary: Got some active links in your document? Do 
you want to have them activated when you click on 
them, or do you want to require another step and have 
them activated when you hold down the Ctrl key and 
click on them? The choice in behavior is up to you; 
here's how to change it. (This tip works with MS Word 
2007.)  
 

Fay has two documents linked to each other—a form 
linked to an information document. On her work PC 
when she hovers the mouse pointer over the link it 
shows as a "pointer hand." On her PC at home she 
doesn't get the hand, but can right-click and select to 
open the link. Fay is wondering why the behavior is dif-
ferent on the two systems and what she can do to fix 
her home PC. 
 

The behavior difference that Fay notes is actually con-
trolled by a configuration setting within Word. Click the 
Office button and then choose Word Options. Click Ad-
vanced and display the Editing Options portion of the 
options. (This is the options at the very top of the ad-
vanced options.) (Click here to see a related figure.)  
 

Pay attention to the setting named Use CTRL+Click to 

Follow Hyperlink. If this check box is selected then 

Word requires the use of the Ctrl key to activate the link 

(or, as Fay did, right-clicking the link and selecting to 

open it.) If the check box is unselected then you'll get 

the "pointer hand" and be able to simply click on a link 

to follow it. 
 

Copyright © 2010 by Sharon Parq Associates, Inc. Re-
printed by permission. Thousands of free Microsoft 
Word tips can be found online at http://word.tips.net. 

Don’t Bring In a Virus 

 
Although USB flash drives give you the ability to 

transport your files between work and home, you’ll 

want to make certain you don’t introduce a virus, 

which may have been on your home computer, 

onto your office network. If you have antivirus and 

antimalware software on your home PC, use the 

software to scan your USB flash drive before you 

take the flash drive to work.  

 
Reprinted with permission from Smart Computing.  Visit 

http://www.smartcomputing.com to learn what Smart Computing can 
do for you and your user group! 

Short video of the usefulness of 140-year-old technolo-
gy:   http://www.wimp.com/neatexperiment/ 

http://www.loraincounty.com/
http://wordribbon.tips.net/FigFiles/T6052F1.html
http://word.tips.net
http://www.smartcomputing.com
http://www.smartcomputing.com/
http://www.wimp.com/neatexperiment/
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Computer Systems Unlimited, Inc.  
 

We are a full service computer/peripheral 
sales and repair Company specializing in 
custom built Pc's, network design, software 
integration, and everything in-between. We 
are located in the small college town of 
Oberlin, Ohio, and for fourteen years have 

been providing unrivaled service to home users, small and large busi-
nesses all over Ohio as well as State and local government  agen-
cies.  All of our systems and networks are tailored to meet the individ-
ual needs of our customers. 
 

Onsite service and repair for all networks and systems, In house 
service and repair, Pick up and drop off,  Printer repair and cleaning, 
Laptop repair, Software troubleshooting, Custom designed networks 
and pc's, MAC repair, Parts replacement & Expert advice and support 
and Data Recovery. 
 

* Computer Systems Unlimited is happy to offer a 5% discount 
on all computer systems ordered by LCCUG members.  
* Computer Systems Unlimited will also offer a free computer 
diagnostics check, (a $25 value), for all LCCUG members.  
 

Visit our web site at www.csuoberlin.com for more of what we can do. 

Store Hour Monday 9-5:30 - Thursday 9-5:30 - Friday 9-5 - Saturday 9-1  

When you are editing your document, there are many 
times that Word tries to guess what you are doing and 
then complete your task for you. This helpfulness can be 
aggravating at times. One such instance is when you 
are trying to use the mouse to select text from the mid-
dle of one word to the middle of another. Whenever you 
click inside a word and then start dragging the mouse, 
Word assumes you want to make a selection. As soon 
as you move the mouse pointer outside the word, the 
program assumes you wanted to select the entire first 
word in which you originally clicked. 
 
If you want to ensure that Word doesn‘t make that as-
sumption, you need to follow these steps to turn off the 
offending feature in Word 97 through Word 2003: 

1. Choose Options from the Tools menu. Word 
displays the Options dialog box. 

2. Make sure the Edit tab is selected 

The Edit tab of the Options dialog box. 
 

3. Make sure the When Selecting, Automatically 
Select Entire Word check box is cleared. 

4. Click on OK. 

You can follow these steps if you are using Word 2007 
or Word 2010: 

1. Display the Word Options dialog box. (In Word 
2007 click the Office button, then choose 
Word Options. In Word 2010 display the File 
tab of the ribbon, then click Options.) 

Automatically Selecting  
Words 

2. Click Advanced at the left side of the screen. 

The Advanced area of the Word Options dialog box. 
 

3. In the Editing Options area, make sure the 
When Selecting, Automatically Select Entire 
Word check box is cleared. 

4. Click on OK. 

Copyright © 2010 by Sharon Parq Associates, Inc. Re-
printed by permission. Thousands of free Microsoft 
Word tips can be found online at http://word.tips.net. 

The most useless machine ever: http://
www.youtube.com/watch?v=Z86V_ICUCD4 
 
Hallelujah Chorus in a Christmas Food Court: http://
www.youtube.com/watch?v=SXh7JR9oKVE 
 
Flash Mob video from a little closer to home (OSU): 
http://www.youtube.com/watch?v=UJux_VTITfI 

http://www.csuoberlin.com/
http://word.tips.net
http://www.youtube.com/watch?v=Z86V_ICUCD4
http://www.youtube.com/watch?v=Z86V_ICUCD4
http://www.youtube.com/watch?v=SXh7JR9oKVE
http://www.youtube.com/watch?v=SXh7JR9oKVE
http://www.youtube.com/watch?v=UJux_VTITfI
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 COMPUTER REPAIR 

 PRINTERS & SUPPLIES 

 UPGRADES 

* CUSTOM PC'S & LAPTOPS 

* CALL FOR BEST PRICES 

* EDUCATION DISCOUNTS 

 LCD MONITORS & TVS 

365-2288 - Elyria  1-800-238-8973 - USA  
 

591 Cleveland Street   Elyria, Ohio  44035 

Shop at    www.ROYALBUSINESS.com    and save $$$ 
 

Financing Available  -  90 days same as cash 

Facebook Hacker Spreads 

Nasty Photos of Victims 
 
By Micky Knickman 

 

What's your favorite color?  Who was your best friend in 

High School?  What's your favorite food? 

 

If you answered any of these questions truthfully, you 

could be exposing yourself to online security risks.   

 

Most Web services that require a User ID and password 

also require that you create "Secret Questions" that will 

be asked if you should need to reset your password in 

the future.  Hackers will scour the Internet looking for in-

formation about people (Facebook is a treasure trove of 

information that people willingly divulge about them-

selves) and then compile that information and go to var-

ious web sites, like Facebook itself, and then click on the 

Forgot Password link.  The site presents them with the pre-

viously created Secret Questions, which the hacker now 

knows because people willingly give out that information 

in social media and other sites. 

 

Recently, one such hacker was arrested who, after get-

ting access to lots of peoples' accounts, found nude 

photos of them and sent those photos to all their 

friends.  The story can be read here:  

http://www.infopackets.com/news/

inter-

net/2011/20110117_facebook_hacker_spreads_nasty_ph

otos_of_victims.htm and the original story is here:  http://

news.cnet.com/8301-17852_3-20028656-71.html 

 

It's important to learn from this that you should NOT cre-

ate Secret Questions that can be found out by your 

friends, family or anyone else.  I personally ALWAYS LIE 

when filling out forms on Web pages other than bank 

sites, or where I'm purchasing something and need to be 

truthful.  It's none of these sites' business about our per-

sonal information.  When I'm filling out a new registration, 

sometimes I'm male, sometimes I'm female, and I never 

use my correct birthdate.  My favorite food might be 

"pine cones" on one site and "small rocks" on another 

site.  My Mother has had many Maiden Names at various 

sites:  "Sassafras", "NoneOfYourBusiness", etc.  Note that 

these are NOT really the ones that I use, but examples of 

how outrageous your answers should be; NEVER answer 

truthfully.  Even on Bank sites, I use different Mother's 

Maiden Names, because it really doesn't matter what 

you create as long as you give the correct answer when 

you need to prove it's you.  In one of the articles linked 

above, someone uses ―Michael Jackson‖ as his Mother’s 

Maiden Name.  I think that’s great, although I’d be in-

clined to use something more obscure. 

 

Speaking of giving the correct answer, with all these dif-

ferent, false answers, you really need a good system to 

keep track of all your IDs, passwords and Secret Ques-

tions.  I personally use Keepass (http://keepass.info) for all 

my credentials.  This small program uses one master pass-

word to open the database and then allows you to see 

& edit all your other logon IDs & passwords.  When not in 

use, the database is encrypted, so no one without the 

password can see any of the information.  Keepass also 

can be kept on a portable USB drive and carried with 

you to other computers. 

 

 So, start being creative with your personal information 

and "lie like the devil".  Remember, "on the Internet, no 

one knows you're a dog"!  

 

8. Take advantage of your membership!  Lorain 

County Computer Users Group exists to help 

the members learn more and discover what is 

happening in the world of technology! Decide 

to go online and read the monthly newsletter 

(http://lccug.com/newsletters).  Another excel-

lent New Years Resolution would be to attend 

more meetings.  Ask the members who attend 

regularly and they will tell you the value they 

get from doing so!  This is a place to ask a ques-

tion and get an answer!  And definitely learn 

about NEW technologies.  Discover things that 

you didn’t even know you didn’t know.   

 

Let LCCUG show you the way! 
      

     Sandee 

(Continued from page 2) Presidents Letter 

http://www.ROYALBUSINESS.com
http://www.ROYALBUSINESS.com
http://www.ROYALBUSINESS.com
http://www.ROYALBUSINESS.com
http://www.ROYALBUSINESS.com
http://www.ROYALBUSINESS.com
http://www.ROYALBUSINESS.com
http://www.ROYALBUSINESS.com
http://www.ROYALBUSINESS.com
http://www.ROYALBUSINESS.com
http://www.royalbusiness.com/
http://www.royalbusiness.com/
http://www.ROYALBUSINESS.com
http://www.ROYALBUSINESS.com
http://www.ROYALBUSINESS.com
http://www.infopackets.com/news/internet/2011/20110117_facebook_hacker_spreads_nasty_photos_of_victims.htm
http://www.infopackets.com/news/internet/2011/20110117_facebook_hacker_spreads_nasty_photos_of_victims.htm
http://www.infopackets.com/news/internet/2011/20110117_facebook_hacker_spreads_nasty_photos_of_victims.htm
http://www.infopackets.com/news/internet/2011/20110117_facebook_hacker_spreads_nasty_photos_of_victims.htm
http://news.cnet.com/8301-17852_3-20028656-71.html
http://news.cnet.com/8301-17852_3-20028656-71.html
http://keepass.info
http://lccug.com/newsletters
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Do you keep track of information based on week-ending 
dates? Many businesses do, and therefore need a quick 
way to calculate the week-ending dates for the com-
plete year. The dates could be easily calculated with a 
macro, but you can do it just as easily with formulas. 
 

There are two formulas you can use in order to calcu-
late your week-ending dates. Let‘s assume, for the sake 
of this example, that your year is stored in cell A1. You 
could then figure out the first Saturday of the year by 
using this formula in cell A3: 

 
This works because the WEEKDAY function returns a 
value of 1 (Sunday) through 7 (Saturday) for any date. If 
you subtract that value from 7, then you have a value of 
6 (Sunday) through 0 (Saturday). When you add that 
value to the DATE value for January 1 of the year, you 
end up with the first Saturday of the year. 
 

If you prefer to have your weeks end on Fridays, then 
the formula needs to change a bit: 

 
Finally, if you prefer to have your weeks end on Sun-
days, then the formula needs to be like this one: 

 
This formula uses a parameter for the WEEKDAY func-
tion that calculates weekdays that range from 1 
(Monday) through 7 (Sunday). 
Once you have the first week-ending date for the year 
(in A3, remember?), then you can calculate the rest of 
the week-ending dates for the year. Place the following 
formula in cell A4: 

 
This checks to see if one week past the previous date is 
still in the year. If it is, then the new date is returned. If it 
isn‘t, then an empty string is returned. If you copy this 
formula from A4 down through A55, then you will have 
all the desired week-ending dates for the year. With the 
formulas in place, simply change the year in cell A1 to 
see how the dates change. 
 

The range A3:A55 provides room for 53 week-ending 
dates, which is possible for any given year. Because 
you used the IF statement in the formula in cells 
A4:A55, then the very last value (A55) will be blank if 
there were only 52 week-ending dates for the year. 
 
Copyright © 2010 by Sharon Parq Associates, Inc. Reprinted 
by permission. Thousands of free Microsoft Excel tips can be 
found online at http://excel.tips.net. 

=DATE(A1,1,1)+7-WEEKDAY(DATE(A1,1,1)) 

=DATE(A1,1,1)+7-(WEEKDAY(DATE(A1,1,1)

=DATE(A1,1,1)+7-WEEKDAY(DATE(A1,1,1),2) 

=IF(YEAR(A3+7)=$A$1,A3+7,"") 

Calculating Week- 
Ending Dates 

Excel includes several different form controls that you 
can add to your worksheets.   One of these controls is a 
combo box. This control allows you to pick an option 
from a drop-down list, and then determine what was 
picked. To create a combo box, follow these steps: 
 

Somewhere in your worksheet, create a list that speci-
fies what you want to appear in the combo box. For in-
stance, if you have a list of names you want to appear in 
the combo box, create that list of names in your work-
sheet. (For this example, let's assume that you create 
the list in cells K7 through K13.) 
 

1. In versions of Excel prior to Excel 2007 make sure the 
Forms toolbar is displayed. (Choose View | Toolbars | 
Forms.) In Excel 2007, click on the Developer tab of the 
ribbon. (The controls are visible when you click the In-
sert tool in the Controls group on the ribbon.) 
2. Click on the Combo Box tool in the toolbar or ribbon. 
The mouse pointer changes to a small crosshair. 
3. Create the actual combo box by clicking and dragging 
to define the parameters of the control. When you re-
lease the mouse button, the combo box appears in your 
worksheet. 
4. Right-click on the newly created combo box. A Con-
text menu appears. 
5. Choose the Format Control option from the Context 
menu. Excel displays the Control tab of the Format Con-
trol dialog box. (Click here to see a related figure.)  
6. In the Input Range box, specify the range used by the 
list you created in step 1. (For instance, K7:K13.) You 
can also click once in the Input Range box and then use 
the mouse to select the range in the worksheet. 
7. In the Cell Link box, specify the worksheet cell that 
you want to contain the index value of what is selected 
in the combo box. 
8. Click on OK. 
 

Your combo box should now work properly. If you click 

on the down-arrow to the right of the combo box, you 

should see the items from you list. If someone selects 

an option in the combo box, the cell you specified in 

step 7 is updated to contain the relative position of the 

item selected in the combo box. In other words, if some 

selects the fourth item in the combo box, then the cell 

specified in step 7 will contain the value 4. (Similarly, if 

you change the value at that cell—the one specified in 

step 7—to a different value, then Excel changes what is 

displayed in the combo box.) 
 

Copyright © 2010 by Sharon Parq Associates, Inc. Reprinted 
by permission. Thousands of free Microsoft Excel tips can be 
found online at http://excel.tips.net. 

Adding and Using a  
Combo Box 

Funny video of a talking photo booth:   
http://www.wimp.com/photobooth/ 

http://excel.tips.net
http://excel.tips.net/
http://excelribbon.tips.net/Pages/T006747_Displaying_Excels_Developer_Tab.html
http://excel.tips.net/FigFiles/T2711F1.html
http://excel.tips.net
http://excel.tips.net/
http://www.wimp.com/photobooth/
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LCCUG O NGOING  CLASSES  
AND  WORKSHOPS  

 ALL  ARE  FREE  AND  OPEN  TO  THE  P UBLIC  

 

  Date:  February 15, 2011 

  Time:  5:30 - 8 pm  Instructor:  Micky Knickman, et al. 

  Place:  Amherst Church of the Nazarene 
   210 Cooper Foster Park Rd.,44001 

 

 

   Learn how to repair or update your computer by changing 
hard drives, memory, CD ROMs, etc. 
 Members are encouraged to bring their computers any-
time before 7:30 pm for assistance from Micky, Neil or other 
knowledgeable members.  

Problem Solving Workshop 

NEED HELP?— 
Here‘s Who to Contact: 

 
Neil Higgins 
  

 440-967-9061 - higgins.neil@gmail.com 
 Evenings 6 p.m. -10 p.m. + Weekends 
  Hardware, Linux & Windows Operating Systems,  
 Tweaking your system 

 

Micky Knickman 
     

 440-967-3118 - micky@knickman.com 
  Evenings 5 p.m. – 8 p.m. + Weekends 
   General Software Configuration, Hardware Installation,  
 Basic to Advanced Windows 
 

Lou Koch 
    

 440-985-1585 - lkkoch@centurytel.net 
   Microsoft Office: Excel, Word, PowerPoint, Publisher, Access, & 
 Outlook, Basic to Advanced Windows 
 

Edie Lewandowski 
    

 440-282-4188 - elew@erienet.net 
   Daytime - midnight 
   Desktop Publishing, General File Management, Eudora Email, 
 MSWorks Tools,  
 

 Richard Barnett 
      

 440-365-9442 - Richard216@aol.com 
    Evenings & Weekends 
   General Software Configuration, HardwareInstallation, Basic to 
 Advanced Windows & Web Page Design 

 

Sandee Ruth  
   

 440-984-2692 - sandee29@gmail.com 
  6 p.m. - 10 p.m. except when at work 
   Basic Word Processing, Windows,  & Web Design 

   Advanced Internet  
 

Jeff Kasler 
    

 440-967-7142 - Jeffk@roadrunner.com  
   10 a.m. - 7 p.m. 

   Burning CDs using Record Now  
 

David Kennett 
    

 440-327-8624 - w8kfj@yahoo.com 
 9 a.m. - 8 p.m.   
 Video Editing & DVD Burning 
 

Cathy Ratcliff 

 

 therats1@verizon.net 
 Though she lives in Coshocton, you can call  
 740-327-1483  before 8 pm 
 Paint Shop Pro, other Photo Editing programs, 
 Microsoft Office programs  
 
Keith Kuhn 
    

 440-967-6509 - kthkuhn@yahoo.com 
 8 a.m. - 11 p.m.   
 Downloading Music & Burning CDs 

Don’t forget to check the Members’ page for up-to-date infor-

mation about programs & events: 

http://www.lccug.com/members 

Date:  February 15, 2011 

Time: 3:00 - 5:00 pm 
Instructor:  Pam Rihel 
Place:  LCCC Learning Center. 
  St. Joe‘s Com. Center,  21st & Broadway 

  

 Learn more about finding your ancestors with public rec-
ords & online websites.  How to start & sources to use. 
 

You must register   -  Phone: 440-277-6076  or 
Email: LadyGeneo@roadrunner.com 

Genealogy Class 

Date:  February 8, 2011 

Time: 3:00 - 5:00 pm 
Instructor:  Jean Griffith 
Place:  LCCC Learning Center. 
  St. Joe‘s Com. Center,  21st & Broadway 
 

Bring your questions if you‘d like.  Jean will start with the 
basics and move on to intermediate topics if time allows. 
Learn MS Word, copying & pasting, for-matting text, saving 
files, basic file management, basic PC maintenance, etc 

 

Register by calling LCCC Learning Center:    
440-366-4507 

Intermediate Computing 

We are looking for teachers.  Volunteer 

to teach something you know something about.  You 
don‘t have to be a master of the subject; both teachers 
and students usually learn!  LCCC has a great comput-
er lab at St. Joseph‘s Community Center,  that we are 
able to use.  You just have to call Dina and set up a 
time for your class and to let her know if she is taking 
the reservations or if you are.   
Dina: 233-7240 or 366-4507 
 
Let one of the officers know so we can put it in the 
classes section of our newsletter and on our web pag-
es. 

mailto:higgins.neil@gmail.com
mailto:micky@knickman.com
mailto:lkkoch@centurytel.net
mailto:elew@erienet.net
mailto:Richard216@aol.com
mailto:sandee29@gmail.com
mailto:Jeffk@roadrunner.com
mailto:w8kfj@yahoo.com
mailto:therats1@verizon.net
mailto:kthkuhn@yahoo.com
http://www.lccug.com/members
mailto:LadyGeneo@roadrunner.com
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February 2011 Classes 

Class Type Location Registration February Time More Info 

Classes / Workshops 

Problem Solving 
Micky Knickman 

Amherst Church of 
the Nazarene 
210 Cooper Foster 
Park 

  
Not Required 

February 15, 
2011 

5:30 to 8:00 
pm 

Page 10  

Genealogy Class 
Online & Off 
Pam Rihel 

LCCC Learning Center 
St. Joe’s Com. Center 
21st & Broadway 

 

Reg. required  
 

LadyGeneo @ 
roadrunner.com 

February 15, 
2011 

 3:00-5:00 pm Page 10 

Intermediate Com-
puting Class 

LCCC Learning Center 
St. Joe’s Com. Center 
21st & Broadway 

 

Jean Griffith 
 

Register by call-
ing:    

440-366-4507 

February 8, 
2011 

 3:00-5:00 pm Page 10 

Is there a class you would like to teach or a class you would be interested in attending, please let one of our 
officers know. 

We want to fill this last row with something new to be taught.  

The Lorain County Chapter of OGS 
is having it‘s next  meeting on : 

 

February 14, 2011-  Finding Your Ancestor‘s Military 
Papers in the War of 1812 - Speaker: Eric Johnson, 
OGS Trustee, Lt. Col. USAF, retired. 
 

March 14, 2011 - ―The Holdings of the Office of Lorain 
County Clerk of Courts of Common Pleas‖ - Speaker: 
Ron Nabakowski & Sally Pack 
 

Meetings are held the 2nd Monday of the month in the 
North Ridgeville Library on Bainbridge Rd., east off Rt. 
83-just south of Rt. 20.   
 

Meetings start at: Social time 6:30; and 7:00 PM for the 
program.  Meetings are free and open to the public. 
 

Come and enjoy some interesting genealogy programs. 
 

For direction's to North Ridgeville Library follow this link. 
 

http://maps.yahoo.com/#mvt=m&lat=41.385239&lon=-
82.014903&zoom=16&q1=35700%20Bainbridge%

20Road%20North%20Ridgeville%2C%20OH%
2044039 

mailto:LadyGeneo@roadrunner.com
mailto:LadyGeneo@roadrunner.com
http://maps.yahoo.com/#mvt=m&lat=41.385239&lon=-82.014903&zoom=16&q1=35700%20Bainbridge%20Road%20North%20Ridgeville%2C%20OH%2044039
http://maps.yahoo.com/#mvt=m&lat=41.385239&lon=-82.014903&zoom=16&q1=35700%20Bainbridge%20Road%20North%20Ridgeville%2C%20OH%2044039
http://maps.yahoo.com/#mvt=m&lat=41.385239&lon=-82.014903&zoom=16&q1=35700%20Bainbridge%20Road%20North%20Ridgeville%2C%20OH%2044039
http://maps.yahoo.com/#mvt=m&lat=41.385239&lon=-82.014903&zoom=16&q1=35700%20Bainbridge%20Road%20North%20Ridgeville%2C%20OH%2044039
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Predictions for the Top 10 
Scams of 2011 
 
10. Travel and vacations. Americans are still vacation-

ing at home in the weak economy and amid safety 
fears about traveling to Mexico. But with the world 
economy still unsteady, scammers are more desper-
ate than ever to catch out those who do journey 
abroad. Watch out especially for a huge ticket scam 
for the forthcoming London Olympics 2012. 

 

9. Investment scams. Investors have become more cau-
tious about Ponzi schemes, which draw in new money 
to pay earlier investors until the whole scheme col-
lapses. But low interest rates will continue to push 
investors into high-risk and shaky projects. Expect 
also to see more computer trading programs with du-
bious claims that they can "beat the market." 

 

8. Doorstep scams. With the Census out of the way, this 
crime drops two places, but bogus contractors, charity 
collectors, utility workers and others who knock at 
your front door bent on crime keep it strongly in the 
charts. And, of course, a major natural disaster, such 
as hurricane, earthquake or floods, could push this 
higher. 

 

7. Skimming. European banks report a huge increase in 
debit and credit card information theft, especially at 
ATMs that have been rigged either to collect card de-
tails or to trap the card so the crook can use it. Expect 
to see a similar trend in the US during 2011. 

 

6. Bogus and fraudulent Internet sales. As mentioned 
above, this category now embraces bogus retail sites 
selling nothing but thin air, as well as online auctions 
and classified ads. We think this will be more than 
enough to push this category up one further place in 
our Top 10 scams list. 

 

5. Lottery and gaming scams. We've also broadened 
this category to include online gaming scams, fea-
tured in an earlier Scambusters report. We expect to 
see significant growth in bogus gambling-related sites, 
and a continuing stream of phony lottery schemes. 

 

4. Nigerian scams. In their report referred to earlier, 
PandaLabs points out that the latest version of the 
Nigerian scam claims that a compensation fund has 
been set up and invites previous victims to put in a 
claim. Then, of course, the scammer requests a fee 
before the supposed compensation can be released. 

 

Nigerian crooks are also muscling in on the bogus 
girlfriend scam previously dominated by the Russians. 
Victims, befriended online, end up paying supposedly 
for airfares and other expenses for their new but non-
existent sweetheart. 

 

3. Economy related scams. The economy is taking 
much longer to recover than hoped, so expect to see 
foreclosure and load modification scams to continue. 
Plus, as mentioned above, we now include work-from
-home scams in this category. 

 

2. Malware. As many as 60,000 new pieces of malicious 
software appear every day, says McAfee. The grow-
ing use of USB drives to store and transfer data may 
also contribute to the spread of malware. 

 

1. Phishing and identify theft. The growth of malware 
mentioned above, coupled with hijacking of social net-
working accounts and more sophisticated hacking 
technology, means that identity theft will remain the 
Number One Internet crime for the foreseeable future. 

 
Copyright Audri and Jim Lanford.  All rights reserved.  Reprinted with 
permission.  Subscribe free to Internet ScamBusters at  
http//www.scambusters.org 

LinkedIn Adds a Share  
Button 
 

As part of the professional social networking sit‘s push 
toward better social capabilities, LinkedIn 
(www.linkedin.com) has added the ability to embed a 
LinkedIn share button to Web sites.  Much like the famil-
iar row of Facebook, Twitter, and other share buttons 
you may see on some sites, the LinkedIn share button 
provides users a quick and easy way to share whatever 
they‘re reading with people in their LinkedIn network. 
 

Users can choose between three different styles of 

share buttons – a vertically oriented button with a coun-

ter, and a horizontally oriented button with no counter. 

http/www.scambusters.org
http://www.scambusters.org/
http://www.linkedin.com


February 2011|  Interface Volume 23 Issue 2| Page  13 

Are You Giving Away Your 
Personal Information? 
 

Saturday, January 22nd, 2011 |  
 

By Dick Eastman 
 

NOTE: This article has nothing to do with genealogy. 
However, I will suggest that every computer owner and 
every owner of a digital camera should be aware of the 
issues mentioned here. Please feel free to send this arti-
cle to others or to republish it elsewhere, as you see fit. 
 

Would you give a stalker the street address of your 
home? Would you give a pedophile the precise location 
where your children play? If you have posted a picture 
online, you may have already done that.  Pictures taken 
with GPS-equipped digital cameras usually embed the 
GPS coordinates within each picture. Most cameras 
have an option to turn this capability on or off, but the 
default setting usually is ON. Unless you have taken 
action to specify otherwise, the camera probably is re-
cording the exact location of every picture you take, plus 
or minus 10 feet to perhaps 50 feet. 
 

Did you take a picture of your children playing in the 
back yard? That picture probably contains the exact lo-
cation of that back yard, plus or minus a very few feet. 
The same is true for the pictures taken at the Little 
League ballpark, at the school play, or most any other 
place. Did you take a picture of your fancy new car sit-
ting in the driveway? Yes, a car thief now knows where 
to find it. 
 

Not all digital cameras are GPS equipped although most 
―smartphones‖ do have both camera and GPS capabili-
ties. Do you have an Apple iPhone? An Android phone? 
A Windows Phone?  If so, I‘d bet money that you are 
including precise locations with every picture you post 
online. 
 

NOTE: I might lose a few of those bets but I’d win the 
majority. I only bet on sure things. 
Social networking sites are notorious for sharing person-
al information from people who do not realize how much 
privacy they are losing. Did you snap a picture with your 
cell phone  and post it on Facebook? Or on any of the 
photo sharing sites? Facebook Places is especially bad, 
perhaps the worst. I bet that I or anyone else can tell 
you precisely where you took the picture. Again, I only 
bet on sure things. 
 

Luckily, there are several easy solutions. Probably the 
best solution is to turn off the inclusion of GPS data with 
the metadata of the pictures. The exact instructions will 
vary from one camera or cell phone to another. See the 
owner‘s manual or perform a Google search for your 
phone to find the exact instructions. 
 
Another solution, although not nearly as convenient, is 
to use a photo editing program to edit your photo before 

you upload it. Programs like Photoshop Elements can 
erase metadata, including GPS latitude and longitude. 
Since I am a rather devious person and would enjoy 
sending thieves and perverts on a wild goose chase, I‘d 
rather CHANGE the information than erase it. I‘d prefer 
to change one or two numbers in the coordinates rather 
than erase them. Now the photograph points to a loca-
tion several hundred miles away. 
 

Not all photographs need to have the info deleted or 
altered. When I write a newsletter article about a gene-
alogy conference held in Mesa, Arizona, I don‘t care if 
the accompanying photographs indicate a location in the 
convention center. However, if I take a photograph in 
my own living room, I might want to obfuscate that infor-
mation. 
 

Please think about the implications before you upload. 
For more information, look at the I Can Stalk U web site 
at http://www.icanstalku.com and at the 7online.com 
video. 

Summary: Adding a hyperlink to a text selection is easy 
to do in Word. All you need to do is make a couple of 
clicks and specify the target for the link. (This tip works 
with MS Word 2007.)  
 

Word allows you to add hyperlinks to your documents. 
This can come in handy if want active links between 
documents, or if you are creating a Web page using 
Word. You create hyperlinks by following these steps: 
 

1. Select the text in your document that you want to use 
for the hyperlink. 
 

2. Display the Insert tab of the ribbon and click Hyperlink 
in the Links group. Word displays the Insert Hyperlink 
dialog box. (Click here to see a related figure.)  
 

3. The text you selected in step 1 shows up in the Text 
to Display box. You can change the text if you want. 
 

4. In the Address box specify the address for the page 
that will be loaded when the user clicks on your hyper-
link. Typically this is a URL, but it can also be a docu-
ment or resource on your system. You can also select 
an address from the drop-down list or use the Browse 
button to help locate the resource. 
 

5. When completed, click on OK. 

 

Copyright © 2010 by Sharon Parq Associates, Inc. Reprinted 
by permission. Thousands of free Microsoft Word tips can be 
found online at http://word.tips.net. 

Inserting a  
New Hyperlink 

http://www.icanstalku.com/
http://abclocal.go.com/wabc/video?id=7621105
http://wordribbon.tips.net/FigFiles/T6014F1.html
http://word.tips.net
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Mr. Modem 

The End of the Web? 
by Richard Sherman 

 

For more than 10 years, I have been reading arti-

cles proclaiming, "The Web is Dead,‖ attributing its 

passing to a variety of causes, including intrusive 

advertising, malware, pornography, 

and the rise of device-based social 

networking. 
 

I recently attended an online confer-

ence in which the demise of the Web 

was a topic of interest. Within the Web-

based presentation (Irony? What iro-

ny?), the following scenario 

(paraphrased from a Wired article by 

Chris Anderson) was presented as the 

average Internet user's typical day: 
 

"You arise and check email on your bedside iPad. 

During breakfast, you review your overnight texts 

and tweets. At the health club, you work out to 

tunes on your iPod. While driving to the office, you 

listen to a podcast on your smartphone. At work, 

you scroll through RSS feeds and engage in Skype 

and text conversations. At night, you listen to Pan-

dora, play games on Xbox Live, and watch a mov-

ie on your Netflix Roku. Conclusion: You spent most 

of your day on the Internet, but not on the Web 

itself."  (NOTE: If that ever becomes my typical day, 

just shoot me and get it over with.) 
 

What is described above is a world that younger 

consumers are increasingly choosing, not because 

they reject the concept of the Web, but because 

other platforms are a better fit with their pseudo-

busy, self-absorbed, desperate-to-stay-in-touch 

lives. As an added benefit, the screen comes to 

them; they don't have to go to the screen.  Me, 

me, me. 
 

According to some of my techie colleagues, not 

only is the Web on its way to extinction, but email 

itself is also hanging by a thread. (Blasphemers!) 

Contributing to its rumored demise is the advent 

and evolution of texting, smartphones, and mutant 

teenagers with muscular thumbs. "It's too formal," 

declared Facebook-founder and boy billionaire 

Mark Zuckerberg, at the same time (coincidentally) 

that he announced his company's new messaging 

service that has been nicknamed "Gmail killer." All 

the hype and hoo-ha notwithstanding, I disagree. 

Email isn't dead or dying, either. It's fine, and it's go-

ing to be around for many years to come. Some 

have even speculated that email is making a 

comeback—though I must have missed the 

memo, because I didn't know that it ever went 

away. 

 

Within five years, some experts predict that the 

number of individuals accessing the Internet using 

mobile devices will surpass the number of people 

who access it using desktop, laptop, and netbook 

computers combined.  Because devices are small-

er and infinitely more mobile, younger 

users (primarily) will forego their parents' 

generation's general-purpose Web 

browser. 
 

Application developers have observed 

the phenomenal $uccess of low-priced 

iTunes and iPhone applications that ap-

peal to tens of millions of users. This pro-

vides an infinitely more lucrative business 

model than selling software on the Web 

for an annual $29.95 registration fee. 
 

In "The Future of the Internet—And How to Stop It," 

Jonathan Zittrain writes, "It is a mistake to think of 

the Web as the apex of the computer's evolution." 

My sentiments exactly—well, except for the use of 

the word "apex." So what does all this mean for 

most of us? As is frequently the case, there is good 

news, and there is bad news. The good news is 

that we will have many more communication and 

access-to-information options in the future. The 

bad news is that most of them will appear on 

screens too small to read. Mobile devices such as 

the iPhone, iPod, iPad,  
 

Reprinted with permission from Smart Computing.  Visit 
http://www.smartcomputing.com to learn what Smart Computing can 

do for you and your user group! 

LCCUG Treasurer's Report 

12/19 Beginning balance  $   8,648.44  

  membership dues  $       50.00  

  Raffle purchases  $     (416.94) 

1/18 LCCUG Certificate of Deposit  $   5,000.00  

1/18 General Fund balance  $   3,281.50  

Thirty-minute video of close-up card magic: http://
www.ted.com/talks/lang/eng/
lennart_green_does_close_up_card_magic.html 
 
Antwerp Train station musical: http://
www.youtube.com/watch?v=bQLCZOG202k 
 
Coolest business card ever: http://www.youtube.com/
watch?v=13Z7o5Tum_E 

http://www.smartcomputing.com
http://www.ted.com/talks/lang/eng/lennart_green_does_close_up_card_magic.html
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http://www.ted.com/talks/lang/eng/lennart_green_does_close_up_card_magic.html
http://www.youtube.com/watch?v=bQLCZOG202k
http://www.youtube.com/watch?v=bQLCZOG202k
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In many programs, I notice that certain letters in the 
toolbar words are underlined. Why is that? 
 

These are keyboard shortcuts using the Alt key. For 
Instance, if the word File in the toolbar had a line under 
the letter F, then I could hold down Alt+F to open the 
File menu. 

Now, it doesn‘t stop there. Once inside the menu, you 
can use the keyboard to select any of the features listed 
using the underlined key. Actually, in the image above, 
the D key needed to be pressed twice. The first time, it 
went to Export as PDF. 
 
You can go anywhere just by typing the underlined let-
ters with your keyboard. Just follow the dotted line. 
 

~ David 
 
Reprinted with permission from WorldStart.  Visit http://
www.worldstart.com and subscribe to their informative newsletters. 

Fantastic Desktop Wallpapers  
 

 

 

 

 

 

I often get bored with what‘s on my desktop, so I‘m al-

ways looking for new sites that offer awesome desktops 

for free. What I like about this is that they‘ve already 

searched for some of the best desktops out there, and 

have put them all together in one location making it 

easy for you to browse.  

To browse the desktop wallpapers, just scroll down the 

page. If you click the title of the desktop (just above the 

image), or the image itself, you‘ll be whisked away to 

the site that hosts the image (it could be desktopogra-

phy, deviant art, wallpapers-room, etc.). There you can 

download the appropriate size for your desktop. 
 

You‘ll need to follow the download instructions at each 

site to download it. You may just need to click a down-

load button and then right-click the image and chose 

Set as Background.  

I hope you enjoy this collection of desktop wallpapers  

as much as I did! They‘re fantastic! 
 

http://wordpressindeed.com/fantastic-desktop-

wallpapers/  
 

~Amanda  

http://www.worldstart.com
http://www.worldstart.com
http://wordpressindeed.com/fantastic-desktop-wallpapers/
http://wordpressindeed.com/fantastic-desktop-wallpapers/
http://wordpressindeed.com/fantastic-desktop-wallpapers/
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Security  

Use Safety Features In Internet  
Explorer 8  
 

by Stephen J. Bigelow  
 

The Internet has emerged as a pivotal tool for communi-
cation and commerce, but our reliance on Web sites has 
also spawned a series of threats that can potentially 
compromise our security. Generally speaking, we don‘t 
like for Web sites to gather information about us or 
share that information without our knowledge. There are 
also an increasing number of malicious Web sites that 
leverage advanced HTML (Hypertext Markup Language) 
code, Java scripts, and ActiveX controls to infect our 
PCs. Internet Explorer 8 is touted as one of the safest 
and most reliable Web browsers available, but this arti-
cle looks at some additional features that can further 
improve your safety.  
 

Use InPrivate Browsing  
The problem with typical Web browsing is that it leaves 
a trail of cookies, temporary files, Web page history, 
form data, and other traces that often remain on your 
PC long after you‘re finished with the day‘s browsing. 
Some of these traces can be visible to other PC users 
(such as the page history), while other traces (such as 
cookies) can be viewed by other Web sites.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
The InPrivate Browsing feature of IE8 creates a new 
browser environment where all of that potentially sensi-
tive data is held temporarily and then discarded for you 
when the browser window is closed. For example, cook-
ies are held in memory and cleared when the browser 
closes. Temporary files are stored on the hard drive but 
deleted when the browser closes, and so on.  
 

To start an InPrivate browsing session, click the Safety 
menu in IE8 and select InPrivate Browsing, or simply 
use the CTRL-SHIFT-P keyboard shortcut. This opens a 
new IE8 window, and many users will then close the 
previous instance of IE8 from which they launched the 
InPrivate Browsing session. Once you‘re working in the 
InPrivate Browsing instance of IE8, any additional tabs 
will automatically be private. Closing a tab will clear the  

Open a new Internet Explorer 8 window in 
InPrivate Browsing mode to prevent IE8 

content for that page.  
 

Also, keep in mind that InPrivate Browsing disables add
-on toolbars and other extensions by default. To use 
specific toolbars, you may need to enable them specifi-
cally. For example, click Tools, select Manage Add-ons, 
select Toolbars And Extensions, select the feature to 
use, click Enable, and then click Close.  
 

Use InPrivate Filtering  
Another security concern with Web browsing is the way 
that some sites collect information about your browsing 
habits. Many Web sites use that information to push 
content from third-party providers that is tailored to your 
interests; this content includes media such as video, 
advertisements, maps, and more. All of the content may 
look like it‘s originating at the site you visit, but in reality, 
some information about you and your visit are sent back 
to the third-party content provider. Some third-party pro-
viders offer content to a large number of sites, and they 
can eventually assemble a profile of your browsing hab-
its based on the sites you visit.  
 

The InPrivate Filtering feature of IE8 prevents third-
party content providers from collecting information about 
the Web sites that you visit. The feature looks at content 
on the sites that you visit. If it detects the same content 
on multiple sites, you can opt to block that content as 
well as any third-party Web site that is identified in the 
analysis. Chances are that InPrivate Filtering is active 
by default, but you can check it by clicking the Safety 
menu and locating the InPrivate Filtering entry in the 
drop-down menu. If there is a check mark next to the 
entry, the feature is enabled. Otherwise, click the entry 
and the feature should activate (and a check mark will 
appear). You can also press CTRL-SHIFT-F to toggle  
InPrivate Filtering on or off.  
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Use The SmartScreen Filter  
There are more malicious Web sites than ever. Some 
attempt to distribute malware in order to infect or take 
control of your PC, others use phishing tactics to try and 

(Continued on page 19) 

InPrivate Browsing disables add-on toolbars 
and extensions. You’ll need to enable any out-

side tools in order to use them during InPri-
vate Browsing sessions.  

http://www.smartcomputing.com/
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Microsoft Office 2010 
Fresh Looks for SmartArt 
 

BY TREVOR MEERS 
 

If you‘re unfamiliar with Office‘s SmartArt, you may con-
fuse it with charts. Although charts give numbers a 
graphical face, SmartArt provides a more versatile visu-
al platform for a wide variety of ideas in Word, Excel, 
PowerPoint, and Outlook. SmartArt‘s professional-
looking diagrams help you quickly summarize process-
es, organizational structures, cycles, and more. The 
2010 edition of SmartArt preserves much of the design 
and function from previous Office editions.  But there 
are enough new designs—including compelling photo 
options—that make the new SmartArt worth exploring, 
even for experienced users. 
 

Start using SmartArt by clicking the Insert tab‘s Smart-
Art button. The list on the left side sorts the available 
diagrams by type, such as List, Process, Hierarchy, and 
Matrix. Scroll through the designs in the center box until 
you find one you like. Next, click it to see a bigger ex-
ample of it to the right, complete with text explaining 
how the graphic works and the situations for which it‘s 
best suited. 
 

Once you choose a graphic and click OK, Office inserts 
it into your document. A box to the left lets you type text 
and automatically insert it into the appropriate place on 
the graphic. (If you don‘t see the box, click the arrows 
beside the graphic.) If you have trouble making sense 
of where the text box entries will appear on the graphic, 
you can click directly on parts of the graphic and type 
the appropriate text. 

Customize SmartArt 
You can customize most of the elements in a SmartArt 
diagram. In a Cycle Matrix diagram, for example, you  

 
 
 
can click one of the central arrows and drag it to a larger 
size. You can click any shape within the diagram, such 
as one level of a Pyramid List and change its fill color. 
Click a text box, and you can use the Home tab‘s Font 
section to choose a new font, size, and color. 
 

For a quicker overhaul of the entire diagram, click it and 
then click the Design tab. In the SmartArt Styles section, 
click the Change Colors drop-down list to choose from a 
variety of color schemes. These options remake various 
parts of the diagram with several complimentary colors, 
rather than the single color the diagrams originally use. 
 

In addition to altering colors, you can use the gallery of 
designs beside the Change Colors button to add various 
shading and 3D effects to the SmartArt. These styles 
can quickly elevate your graphics to a pro-style look that 
lends your concepts not only clarity but also credibility. 
 

You can quickly experiment with different types of 
SmartArt diagrams for the same information. On the 
Design tab, look in the Layouts section for other dia-
gram styles Office considers a good fit for the infor-
mation you‘ve already entered. If you want even more 
options, click More Layouts and choose a look to try. 
 

New Picture Options 
The new option really worth trying out in Office 2010 is 

the Picture category of SmartArt. These designs let you 

click a link to add your own photos to a big selection of 

diagrams. It‘s an easy way to make information more 

vivid and memorable by using images of real people, 

places, and products. And, of course, adding your pic-

tures helps reach a key goal of any user of a mass-

market product such as Office: creating documents with 

a look that‘s uniquely yours.  
 

Reprinted with permission from Smart Computing.  Visit 
http://www.smartcomputing.com to learn what Smart Computing can 

do for you and your user group! 

A fresh batch of SmartArt diagrams lets you add  
your own photos to graphics, making your point 

instantly more memorable. 

scam you to gain your personal information, and some 
sites do both. With the release of IE8, Microsoft pro-
vides a service that can compare the Web site you are 
visiting against a list of known malicious Web sites. If 
that site is on the list, IE8 blocks the page and the Ad-
dress bar turns red. You can then go to your home 
page, continue to the blocked site, or select another 
site. It‘s your call, but at least you have some warning.  
 

You can toggle the SmartScreen Filter by clicking the 
Safety menu, highlighting the SmartScreen Filter entry, 
and then selecting Turn Off SmartScreen Filter or Turn 
On SmartScreen Filter. Further, you can opt to Check 
This Website to specifically run a check of the URL 
against Microsoft‘s list of malicious sites. And if you be-
lieve that you‘ve stumbled across a fraudulent or mali-
cious Web site, you can select Report Unsafe Website 
to submit a report to Microsoft for further investigation. 
It‘s a simple way of keeping the list up-to-date.  
 

Reprinted with permission from Smart Computing.  Visit 
http://www.smartcomputing.com to learn what Smart Computing can 
do for you and your user group! 

(Continued from page 18) Security 
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Presenter, Know Thy Laptop 
Before you take your laptop with you on the road for 

your first presentation to a group, be aware that many 

laptops with a video-out port require a keyboard combi-

nation to toggle the display signal from the laptop to the 

projector it‘s connected to. For example, one such com-

bination might be CTRL-F5. If you push CTRL-F5 once, 

it will shift the video output to the projector; pushing it 

twice displays the image on your laptop and the projec-

tor. This can vary from laptop to laptop, so consult your 

manual for specific instructions on running your comput-

er through a projector.  

 

Helpful Stickiness 
Notebook PC keyboards are notoriously cramped and 

difficult to use, but there are Windows options that make 

your life easier. The StickyKeys feature simplifies the 

process of pressing multiple key combinations (such as 

CTRL-ALT-DELETE) by making these keys "sticky" so 

you can press them one at a time. This feature is espe-

cially helpful if you have less than agile fingers. From 

the Windows Control Panel, double-click Accessibility 

Options, and then click the StickyKeys checkbox. Click 

Settings to make any changes to your preferences.  

 

Spare Your Hard Drive 
Notebook hard drives are designed to work in a fairly 

motionless environment. That's why when you turn off 

your computer; it retracts its hard drive head to protect it 

from damage during transport. If you continually run 

around with your notebook powered up you increase the 

chances that your hard drive will incur damage.  

Mobile Gmail 
Don‘t get stuck behind a monitor the next time you want 
to check your email. Gmail, Google‘s email service, of-
fers Mobile Gmail, which lets users access Gmail from 
mobile devices such as smartphones and PDAs.  
 

nanojet 
The term for an extremely small jet nozzle (about one-
thousandth the width of a piece of hair) that can stream 
out microscopic material onto silicon surfaces or clean 
impurities or errors off of microchips. Research is cur-
rently being conducted at universities around the world 
to expand upon and perfect various nanojet applica-
tions, such as atomic etching.   
 

Polarizing Posts Are Popular 
Researchers studying forum postings on the BBC‘s 
online discussion site and digg.com have determined 
that angering or upsetting blog posts tend to be the 
most popular. The researchers arrived at this conclusion 
by assigning a ―happiness score‖ to the online postings 
based on emotional content translated from items like 
keywords, emoticons, and misspellings. The posts that 
generated the most responses turned out to be the ones 
that had very low happiness scores. According to one of 
the researchers, ―If you want a long chat, don't start by 
saying ‗I love this!‘‖ 
 

IMDb 
You know that John Wayne was tall, but did you know 
that he stood at 6 feet, 4 inches? Whether you‘re a fan 
of movie trivia or simply want to know more about your 
favorite star, IMDb (the Internet Movie Database) has 
everything you want to know. The site‘s comprehensive 
information has plenty of hyperlinks. Follow the links, 
and you‘ll likely soon discover new (to you) movies that 
interest you.  http://www.imdb.com   
 

 

The Association of Personal 

MEMBERSHIP WITH LCCUG: 
 Yearly dues are $25 .  For more information, contact: 

 

Director of Membership, 

membership@lccug.com. 

 

Directions to Meetings: 
A map and directions to our meetings can be found on our 

Members’ web page www.lccug.com/members.  Just click 

on the link “Meeting Locations & Directions” 

Reprinted with permission from Smart Computing.  Visit 
http://www.smartcomputing.com to learn what Smart Computing can 

do for you and your user group! 
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